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NOTE: This template provides guidelines and examples to illustrate how to structure and format your manuscript for acceptance in the HI-AM Conference Proceedings. Authors should ensure all guidelines and placeholder text, including this notification, are removed before submission. For detailed formatting guidelines, refer to Section ‎9.
Title [22 pt, left-aligned, capitalize only the first word]
First Author1, Second Author1,2, Third Author1,* [10 pt, left-aligned]
1 Laboratory/Research Centre/Institute (optional), Department/School/Faculty (optional), University/Organization, City, Province/State/Region (optional), Postal/Zip Code, Country
2 Laboratory/Research Centre/Institute (optional), Department/School/Faculty (optional), University/Organization, City, Province/State/Region (optional), Postal/Zip Code, Country
* Corresponding author’s email address: johndoe@email.com 
Abstract: Your paper's abstract has been submitted and accepted for conference presentation. Please enter the same abstract; only minor revisions are permitted at this stage. Major changes to the accepted abstract will not be approved. The abstract must be no longer than 300 words and should be a single paragraph.
Keywords: Provide up to five keywords, separated by commas.

Introduction [Heading 1 style: 11 pt, bold, left-aligned | Paragraphs: 11 pt, regular, justified]
Authors with an accepted abstract for presentation at the HI-AM Conference, regardless of their assigned presentation format (oral or poster), may choose to submit a short manuscript for consideration in the conference proceedings. Manuscripts will undergo a thorough peer-review process, separate from the abstract review, and select papers will be published in the proceedings under the Creative Commons Attribution-NonCommercial (CC BY-NC) license. The proceedings will be hosted on an Open Journal System (OJS) platform managed by the University of Waterloo Library, assigned a DOI, and indexed by Google Scholar. Review the Author Agreement before drafting your manuscript. 
The manuscript, including references, figures, and tables, must not exceed four pages in total. For detailed formatting guidelines, refer to Section ‎9. For improved readability, the manuscript should be divided into sections and subsections, using up to three levels of headings. These headings should be numbered using numerical digits based on their level (e.g., 1, 1.1, 1.1.1). Manuscript must include the following main sections and information: title, author(s), affiliation(s), corresponding author’s contact information, introduction, materials and methods, results and discussion, conclusion, and references. If applicable, the manuscript should include sections on acknowledgments, conflicts of interest, and generative AI usage.
The introduction section should provide a clear context for the research, highlighting the problem or question being addressed and its significance to the field. It should include a brief review of relevant literature to establish the gap the study aims to fill, followed by research objectives or hypotheses. The introduction should be concise and set the stage for the methodology and results that follow. 
Sample second level heading [Heading 2 style: 11 pt, bold, left-aligned]
[Insert paragraph here.]
Sample third level heading [Heading 3 style: 11 pt, regular, left-aligned]
[Insert paragraph here.]
Materials and methods
The materials and methods section should provide a clear and detailed description of the materials, equipment, and procedures used in the study, allowing others to replicate the work. It should include information on sample preparation, material and component characterization, modeling details, experimental design, data collection methods, and any statistical analyses performed. The section should be concise, written in the past tense, and structured logically. Authors may use “Heading 2” and “Heading 3” from the list of styles to create appropriate subsections as needed. Avoid using more than three levels of headings.
Results and discussion
The results and discussion section should present and interpret the findings of the study. The results should be reported clearly and concisely, often with the aid of tables, figures, and graphs, without including interpretations. The discussion should then interpret the results in the context of the research questions, compare them to previous studies, and explore their implications. This section should also address any limitations or unexpected outcomes. Authors may use “Heading 2” and “Heading 3” from the list of styles to create appropriate subsections as needed. Avoid using more than three levels of headings.
Conclusion
The conclusion section should summarize the key findings of the study, emphasizing their significance and potential impact. It should briefly restate the main results without repeating detailed data and discuss their implications in the broader context of the field. Additionally, the conclusion may suggest areas for future research or applications. It should be concise and provide a clear closing to the paper.
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The acknowledgment section should recognize individuals, organizations, or institutions that contributed to the research, whether through funding, technical support, or intellectual contributions. It may also include thanks for access to materials, equipment, or data. This section should be brief and formal. 
Note: If your research is funded by one of the HI-AM 2.0 NESRC Alliance grants, you must include the relevant statement below in your manuscript: 
· For research funded by the HI-AM 2.0-Directed Energy Deposition Grant: We acknowledge the support of the Natural Sciences and Engineering Research Council of Canada (NSERC), funding reference number ALLRP 586394-23.
· For research funded by the HI-AM 2.0-Powder Bed Fusion and Binder Jetting Grant: We acknowledge the support of the Natural Sciences and Engineering Research Council of Canada (NSERC), funding reference number ALLRP 586345-24.
Conflicts of interest
Disclose any financial or personal relationships that could influence your research in the conflicts of interest section. Include information on funding sources, ownership interests, advisory roles, or any affiliations that may create potential bias.
Statement on generative artificial intelligence (AI) usage
Use of generative AI technologies in manuscript preparation is restricted solely to language editing. AI cannot be listed as an author, and AI applications such as data analysis, image generation or augmentation, and text authoring are not permitted. If generative AI is used for language editing, you must include a statement in this section specifying the tool used, the extent of its use, and a confirmation that you have thoroughly reviewed and edited the AI-generated content. By doing so, you affirm authorship of the final text and accept full responsibility for it. Use the following template:
In the preparation of this manuscript, [AI tool name] was used solely for language editing purposes. The tool was applied to [specify extent, e.g., grammar refinement, clarity improvements], and all AI-generated content has been thoroughly reviewed and edited by the authors to ensure originality and accuracy. We, the authors, affirm full authorship of the final text and accept complete responsibility for its content.
References
The references section should list all sources cited throughout the manuscript, following the Vancouver citation style as described in Section ‎9.9. The references should be organized by the order of citation. 
[bookmark: _Ref182218846]Formatting Guidelines 
[bookmark: _Ref182231010]Overall instructions 
This template has been prepared using Microsoft® 365 Word (Version 2410) and saved in .docx format. The HI-AM Conference currently does not accept LaTeX files. The formatting, spacing, fonts, margins, etc., described below are pre-set in this template. Please do not alter these settings. Any changes or deviations from the established standards may result in the rejection of the manuscript.
· The manuscript must be US letter-sized (8.5″ × 11″ or 21.6 cm × 27.9 cm), with left and right margins set to 1.5 cm (0.59″), and top and bottom margins set to 0.5 cm (0.197″).
· The required font for the manuscript is Times New Roman (TNR). Font sizes for each section are provided below and indicated throughout the template in brackets:
· Title: TNR, 22 pt, regular, left-aligned
· Body text (paragraphs), abstract, keywords: TNR, 11 pt, regular, justified
· Authors, affiliations: TNR, 10 pt, regular, left-aligned
· First and second level headings: TNR, 11 pt, bold, left-aligned
· Third level heading: TNR, 11 pt, regular, left-aligned
· Equations: Cambria Math, 11 pt, italic, centred
· Inline math symbols: Cambria Math, 11 pt, italic, left-aligned
· Caption and table text: TNR, 10 pt, regular, centred
· References: TNR, 9 pt, regular, left-aligned
· The manuscript must be formatted as single-column and single-spaced.
· The spacing after paragraphs and headings of all levels should be set to 4 pt. The spacing before paragraphs is 0 pt, before the first-level headings is 12 pt, and before second- and third-level headings is 8 pt. Do not leave blank lines between paragraphs or before a heading.
· All paragraphs should be justified. The first sentence of a paragraph should not be indented.
· All text, including title and headers, should be left-aligned, while figures, tables, and captions should be centred. 
Language
All manuscripts should be written in English. The HI-AM Conference's preferred spelling and typographical conventions are based on Canadian English. For guidelines, please refer to the Canadian Oxford Dictionary. Authors may alternatively use American or British English spelling, provided they maintain consistency throughout the document.
Accessibility
The conference is dedicated to upholding accessibility guidelines and has developed an accessible manuscript format to support this commitment. As authors, you play a crucial role in ensuring the accessibility of the content you submit. Please review this article for detailed guidance on creating accessible content, including instructions on adding alt text to figures and tables.
Title, authors, and abstract
The manuscript’s front matter includes the title, list of authors and affiliations, abstract, and keywords. This template is set up for three authors and two affiliations; authors should adjust the number as needed and format details according to the guidelines below: 
· Enter the same title and abstract as those submitted and accepted for presentation. Only minor revisions are allowed at this stage; significant changes may result in paper rejection.
· Only capitalize the first letter of the title and subtitle (if applicable) and any proper nouns. Avoid capitalizing the first letter of every word.
· For each author, provide the First Name, Middle Initial (optional), and Last Name. Affiliations should be numbered in the order they correspond to the authors, using standard numerical digits (1, 2, 3, …), and the numbers should be in superscript. If one author is affiliated with more than one place, separate the numbers with comma (1, 2).
· The corresponding author should be indicated with a superscript asterisk (*), and their email address must be provided.
· For each affiliation, provide the name of the organization, city, province/state, postal/zip code, and country. Authors may also include the name of their laboratory or research centre and department if applicable. All names should be capitalized and given according to the official standard name of the institution. Abbreviations are not acceptable.
Heading structure
Up to three levels of heading are allowed for organizing the manuscript. Each level corresponds to the Heading 1, Heading 2, and Heading 3 styles, as described in Section ‎9.1. First-level headings identify the main sections of the manuscript (i.e., introduction, materials and methods, results and discussion, conclusion, acknowledgement, and references) and must be included in all papers. Authors may add second- and third-level subsections as needed. Please adhere to the following formatting guidelines: 
· Only capitalize the first letter of the headings. Avoid capitalizing the first letter of every word.
· Avoid using abbreviations in headings whenever possible.
· Headings should be numbered using the customized multilevel listing activated in this document. Numbers should be followed by a period (.), with single space between the period and the heading text. 
Example: 1. Introduction
Lists
If a list is required, authors may use bullets (solid or hollow round bullet), numbers, or letters. The lists should be formatted using the “List Paragraph” style, which is set based on the following guidelines.
· Type your list first, apply the “List Paragraph” style from the Syles group to your list, and then select the desired bullet type from the Paragraph group.
· The choice of numbering style is at the authors’ discretion but should be maintained throughout the manuscript.
· All lines of each item are set to be indented by 0.5 cm.
Figures, tables, captions, and alt texts
Tables and figures should be placed in line with text and numbered consecutively. Avoid wrappong text around them, and do not leave blank lines immediately before or after each table or figure. Note that using any wrap text style other than "in line with text" violates accessibility guidelines, as screen readers cannot recognize such images in PDFs, even if alt text is provided. 
All figures and tables must include both captions and alt texts. Place figure captions below the figures and table captions above the tables. Keep captions and alt texts consice, and avoid including details that belong in the results and discussion section. Figure 1 and Table 1 provide examples of proper presentation. Refer to the following guidelines for further details:
Figures and plots
· For images adopted from other sources, with or without modifications, it is the responsibility of the authors to ensure that all necessary permissions are obtained. This includes verifying that the correct references are cited, and all required attributions are provided in accordance with the applicable copyright terms. Authors must esnure that the usage complies with licensing conditions, and that proper credit is given to original creators.
· Captions should begin with “Figure #” followed by a period (e.g., Figure 1. Phase diagram of hydrogen.). Captions should end with a period. Capitalize the first letter of the caption, and ensure there is a space between the period and the first letter. Figures should be referenced in the text by their label and number only, e.g., Figure 1. All figures must be referenced in the text.
· Include descriptive alt text for each figure or chart to explain its content. Alt text is required even when a caption is included and serves as an additional description. For guidance on adding alt text to a figure in Microsoft Word, refer to this link.
· Use high-resolution images (300 dpi) and ensure they remain clear and sharp after being inserted and resized to the appropriate dimensions. Low-resolution images with unreadable text or blurry elements may be rejected.
· Use TIFF, PNG, or vector file formats for optimal quality, especially for plots.
· Compress images without significant loss of quality to keep the manuscript’s file size manageable.
· Ensure that images are consistently sized and maintain the same aspect ratio to prevent distortion.
· Use color judiciously and esnure that figures remain clearly interpretable when the manuscript is printed in black and white. Refer to this article for guidelines on incorporating accessibility considerations in image design, color selection, and contrast.
· Use standard, readable fonts (e.g., Times New Roman or Arial) in images and maintain font consistency across all figures. 
· In plots, label all axes clearly and include the appropriate units.
[image: Phase diagram of hydrogen, with pressure (in pascals) on the X-axis and temperature (in Kelvin) on the Y-axis.]
[bookmark: _Ref182294769]Figure 1. Phase diagram of hydrogen by Cmglee, CC BY-SA 4.0, via Wikimedia Commons [1]. [10 pt, centred]
Tables
· Captions should begin with “Table #” followed by a period (e.g., Table 1. The weight and height of the components.). Captions should end with a period. Capitalize the first letter of the caption, and ensure there is a space between the period and the first letter. Tables should be referenced in the text by their label and number only, e.g., Table 1. All tables must be referenced in the text.
· Include descriptive alt text for each table to briefly explain its content. Alt text is required even when a caption is included and serves as an additional description. For guidance on adding alt text to a table in Microsoft Word, refer to this link.
· Table formatting should be consistent throughout the text and follow the example provided in Table 1.
· The table text should be in TNR, 10 pt, and centred. Table headers may be bolded for emphasis.
· Include the units of measurement for all parameters in tables in square brackets next to the parameter.
· The spacing before and after the text in the cell should be set to 1 pt.
[bookmark: _Ref182294783]Table 1. The weight and height of the components. [10 pt, centred]
	Item
	Weight [g]
	Height [cm]

	1
	200 ± 2
	54 ± 3

	2
	322 ± 4
	68 ± 2

	3
	180 ± 1
	32 ± 2


Equations
Equations should be placed on a separate line and numbered sequentially as they appear in the text. You may use Microsoft Word’s built-in equation tool (Insert > Symbol group > Equation) or insert equations as an object (Insert > Text group > Object > Microsoft Equation 3.0). Regardless of the method used, ensure consistency and adhere to the following guidelines:
· Equations should be numbered sequentially (1), (2), (3), …. Equation numbers should appear in parentheses. 
· Equations should be centred, with the numbering right-aligned. To achieve this, two tab stops are set at 9.5 cm and 18 cm in this template. Select any line and press the Tab key once to move the cursor to the centre of the line and insert your equation. Then, press Tab again to move to the right edge and insert the equation number (or insert numbering as a field).
· Equations should be referenced in the text as Equation #. 
· Definition of the parameters used in each equation should be provided immediately afterward. Each parameter should be written in Cambria Math, not TNR. Example: Equation 1 was used to calculate the area of the circle.
		(1)		
where  represents the area of the circle and  denotes its radius. 
[bookmark: _Ref182225453]Units
Authors may use SI, CGS, or English units. Always use the same system of units throughout the manuscript and avoid combining units from different systems. If you need to use more than one system, clearly define when and why you are doing so. Refer to the following guidelines for additional details:
· Always use the standard abbreviations for units (e.g., m for meter) and ensure they are in lowercase, except for units named after people (e.g., N for newton). 
· Place a space between the numerical value and the unit (e.g., 10 m, not 10m).
Cross-references
Authors may use cross-references for in-text citations of section, figure, table, or equation numbers and labels. Before submission, ensure that all cross-references are correctly updated, with no errors present.
References and citation
References should be listed in the order they appear in the text. Follow the formatting instructions below:
· Use the Vancouver citation style and apply it consistently throughout the references section.
· For articles, include author(s), title, journal, publication date, volume, issue number, and page range:
[1] Einstein A, Podolsky B, Rosen N. Can quantum-mechanical description of physical reality be considered complete?. Physical review. 1935 May 15;47(10):777. [TNR, 9 pt, regular, left-aligned]
· Vancouver in-text citations use numbers placed next to the author’s name or study. The style allows for various formats, but the version accepted by the conference requires numbers in square brackets, not parentheses. Reference numbers should not be in superscript. Examples: 
· One reference: [1]
· Two references: [1,2]
· More than two references: [3-5]
· Combined: [1,3,4], [1,3-5], [1-3, 5-8]
· The reference numbers should appear either immediately after the author’s name or at the end of the sentence, before the period. Examples:
· One author: Smith [1] discovered …
· Two authors: Smith and Jones [1] discovered …
· More than two authors: Smith et al. [1] discovered …
· At the end of a sentence: Recent studies found that the results were inconclusive [2, 4-6].
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